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1 Overview

This document outlines the operation and functionality of the Signal Hound Spike™ spectrum analyzer
software. Spike™ is compatible with Signal Hound's line of spectrum analyzers which include,

e SAseries - SA44 / SA44B / SA124A / SA124B
e TG products-TG44/TG124
e BB series - BB60A / BB60C

This document will guide users through the setup and operation of the software. Users can use this
document to learn what types of measurements the software is capable of, how to perform these
measurements, and configure the software.

1.1 WHAT'S NEW

With Version 3.0, the software has been rebranded Spike™. The SA and TG series products have been
integrated into the software. The software now supports all Signal Hound test and measurement
products.

1.2 SOFTWARE UPDATES

The latest version of the Spike software is always available at www.signalhound.com/Spike. As of Spike
Version 3.0.10, the software will also alert a user when a newer version of the software is available. This
alert will appear in the status bar as well as on the Help->About Spike dialog. The software will provide a
link to where the latest version can be downloaded.
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2 Preparation
2.1 INITIAL INSPECTION

Check the package for shipping damage before opening. The Signal Hound box should contain a USB
cable, a Signal Hound spectrum analyzer and an installation CD.

2.2 SOFTWARE INSTALLATION

The software can be found on the CD included with your purchase or on our website
www.SignalHound.com. The latest software version can always be found on our website.

Once you have located the software, run the setup.exe and follow the on-screen instructions. You must
have administrator privileges to install the software. You may be asked to install the Windows Runtime
Frameworks, as this must be installed for the software to run. The installer will install the device drivers
for the Signal Hound products during installation as well.

It is recommended to install the application folder in the default location.

2.2.7 System Requirements

Supported Operating Systems:

e Windows 7 (32 and 64-bit)
e Windows 8 (32 and 64-bit)
e Windows 10 (32 and 64-bit)

Minimum System Requirements

e Processor requirements depend on which device you are planning to operate
e SA series: Dual-core Intel processors
e BB series: Intel Desktop quad-core i-Series processors (lvybridge generation or later)***
e RAM requirements
o Minimum -4 GB
o Recommended - 8 GB RAM
e The software will on average require less than 1GB of memory
e Peripheral support
e SAseries: USB 2.0
e BB series: Native USB 3.0 support
e Graphics drivers
o Minimum: OpenGL 2.0 support
o Recommended: OpenGL 3.0 support**
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(** Certain display features are accelerated with this functionality, but it is not required.)

(*** Our software is highly optimized for Intel CPUs. We recommend them exclusively.)

2.3 DRIVER INSTALLATION

The drivers shipped for the BB60 are for 32 and 64-bit operating systems and are placed in the
application folder during installation. The \drivers\x86\ folder is for 32-bit drivers and the \drivers\x64\
folder for the 64-bit drivers. The drivers should install automatically during setup. If for some reason the
drivers did not install correctly, you can manually install them in two ways by following the instructions
below.

To manually install the BB-series drivers (e.g. BB60C), navigate to the application folder (where you
installed the Spike software) and find the Drivers64bit.exe file. (If on a 32-bit system, find the
Drivers32bit.exe file) Right click it and Run as administrator. The console text will tell you if the installation
was successful.

To manually install the SA and TG series device drivers (e.g. USB-SA44B, TG44A), navigate to the
application folder (where the Spike software was installed) and find the CDM v2.12.00 WHQL
Certified.exe file. Right click it and Run as administrator. Follow the installation instructions.

If manually running the driver installers did not work, make sure the driver files are located in their
respective folders and follow the instructions below.

You may manually install the drivers through the Windows device manager. On Windows 7 systems with
the device plugged in, click the Start Menu and Device and Printers. Find the FX3 unknown USB 3.0
device and right click the icon and select Properties. From there select the Hardware tab and then
Properties. Select the Change Settings button. Hit the Update Drivers button and then Browse My
Computer for drivers. From there navigate to the BB60 application folder and select the folder name
drivers/x64. Hit OK and wait for the drivers to install.

If for some reason the drivers still did not install properly, contact Signal Hound.

2.4 CONNECTING YOUR SIGNAL HOUND

With the software and device drivers installed, you are ready to connect your device. The supplied device
USB cable should first be connected into the PC first, then connected to the device. If your device
supplies a Y-cable, ensure both USB ends are connected into the PC before connecting the device.

The first time a device is connected to a PC, the PC may take a few seconds recognizing the device and
installing any last drivers. Wait for this process to complete before launching the software.

When the device is ready, the front panel LED should show a constant green color.
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2.5 RUNNING THE SOFTWARE FOR THE FIRST

TIME

Once the software and drivers have been installed and the device is connected to the PC, you can launch
the software. This can be done through the desktop shortcut or the Spike.exe file found in the
installation directory. The default installation directory for Spike on Windows is C:\Program Files\Signal
Hound\Spike. If a device is connected to the PC when the software is launched, the software will attempt
to open the device immediately.

If no device is connected to the PC or if multiple devices are found, the software will notify you. At this
point, connect the device and use the File > Connect Device menu option to open the device.

Note: If you see the IF overload message on program startup, please see this troubleshooting tip.

3 Getting Started

Launching the Spike™ software brings up the Graphical User Interface (GUI). This section describes the
GUI in detail and how the GUI can be used to control the Signal Hound spectrum analyzer.

Below is an image of the software on startup. If a device is connected when the application is launched,
the software begins sweeping the full span of the device:
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Figure 1: Spike™ Graphical User Interface
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3.1 THE GRATICULE

The graticule is a grid of squares used as a reference when displaying sweeps and when making
measurements. The software always displays a 10x10 grid for the graticule. Inside and around the
graticule is text which can help make sense of the graticule and the data displayed within.

3.2 THE MENU
3.2.71 File Menu

Print - Print the current graticule view. The resulting print will not include the control panel
or the menu/toolbars.

Save as Image - Save the current graticule view as a PNG, JPG, or BMP image.

Quick Save Image - Capture the current graticule view as a PNG image without specifying
the file name or save location. The image files are named in increasing order and prefixed
with Spikelmage. The save directory is the last directory used to save an image file. If an
image file has never been saved, this defaults to MyDocuments/SignalHound.

Import - Limit Lines = Import Limit Line Table - Import a set of limit lines which then
the incoming trace is tested against. Limit lines are two lines across the span which defines
an acceptable amplitude region for a trace. See Additional Features: Importing Path Loss
and Limit Line Tables for more information.

Import - Limit Lines = Clear Limit Line Table - Remove the active limit line table.
Connect Device - If no device is connected, this will attempt to discover all Signal Hound
devices connected to the PC and list the devices and their serial numbers. From this list, a
single device can be selected.

Disconnect Device - This option disconnects the currently connected device. This option
combined with “Connect Device” is useful for cycling a devices power or swapping devices
without closing the Signal Hound software.

Exit - Disconnect the device and close the software.

3.2.2 Edit Menu

Restore Default Layout - After selecting this option, the software will restore its original
layout following the next time the application is launched.

Title - Enable or disable a custom title. The title appears above the graticule and is included
in the screen captures via printing as well as session recordings.

Clear Title - Remove the current title.

Colors - Load various default graticule and trace color schemes.

Title - Enable or disable a custom title. The title appears above the graticule and is included
in screen captures via printing as well as session recordings.

Program Style - Select a color theme for the main windows of the application.
Preferences - Opens a configuration dialog allowing the further configuration of the
software. See Getting Started: Preferences.
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3.2.3 Presets

The presets menu bar provides a way for users to manage the preset functionality for the software. Each
preset offers the capability to recall a full software configuration. This is convenient for recalling specific
measurement configurations. Presets can be renamed. Presets can be recalled with keyboard shortcuts.

Presets can only be loaded by the same type of device which was used when the preset was saved.

Presets are stored in C:\Users\YourUserName\AppData\Roaming\SignalHound\. AppData\ is a hidden
folder by default on Windows systems. The presets are named “Preset[0-8].ini" and correspond to
Presets[1-9] in the software. To use a preset on a different computer, simply copy the preset to the new
computer in the correct path.

3.2.4 Settings

Reference - Change the source of the reference oscillator. Internal or external reference
can be chosen. If external reference is chosen, ensure a 10MHz reference is connected to
the appropriate BNC port.

o Internal - Use the internal 10MHz clock

o External Sin Wave - Use an external AC 10MHz reference clock

o External CMOS-TTL - Use an external 10MHz CMOS input clock.
Spur Reject - When spur rejection is on additional signal processing is enabled attempting
to remove spurious signals which are the result of mixing products. Spur rejection roughly
doubles sweep time and is great for cleaning up a steady signal, but should not be used for
pulsed RF, or modulated signals. Spur rejection is not available in real-time mode.
Enable Manual Gain/Atten - Enable the ability to change gain and attenuation.

3.2.5 Analysis Mode

Idle - Suspend operation.

Sweep - Enter standard swept analysis. See Modes of Operation: Swept Analysis.
Real-Time- Enter real-time analysis mode. See Modes of Operation: Real-Time Spectrum
Analysis.

Zero-Span - Enter zero-span mode. See Modes of Operation: Zero-Span Analysis.
Harmonics Viewer - Selecting harmonics viewer displays the amplitude of the first 5
harmonics of the center frequency.

Scalar Network Analyzer - If a SA series spectrum analyzer device is currently active and a
Signal Hound tracking generator is connected to the PC, the software will set up the system
as a scalar network analyzer. See Modes of Operation: Scalar Network Analyzer.

Phase Noise Plot - Displays the phase noise amplitude in dBc/Hz vs. offset from carrier
when checked. The carrier should be within 10kHz of the current center frequency. The
data is approximate and is limited by the phase noise of the Signal Hound itself. For best
phase noise measurements, use an external 10 MHz reference. The phase noise plot is only
available for select Signal Hound spectrum analyzers.

Modulation Analysis - Start the digital modulation analysis portion of the software. See
Modes of Operation: Digital Demodulation.

10
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3.2.6 Utilities

Path Loss Tables - Bring up dialog to add and remove path loss tables and antenna
corrections. See Managing Loss Tables for more information.

Audio Player - Bring up the dialog box to use and customize the software for audio
playback. See Audio Player for more information.

Measuring Receiver - Enables the measuring receiver utility. See Using the Measuring
Receiver Utility for more information.

Tracking Generator Controls - If a SA or BB series spectrum analyzer is the current active
device in the software and a Signal Hound tracking generator is connected to the PC,
selecting this utility introduces an additional control panel for controlling the tracking
generator output manually. The tracking generator will only respond if the scalar network
analysis mode is not active.

SA124 IF Output - Brings up a dialog box to control the IF downconverter for the SA124
spectrum analyzers. While the SA124 IF downconverter is active, the device cannot perform
other tasks.

Self Test - Brings up a dialog box to manually self test SA44B and SA124B devices. The
dialog will explain the process of setting up the device for self test and will display the
results immediately after the test is performed.

3.2.7 Help

User Manual - Open the Spike user manual in the system default PDF reader.

Signal Hound Website - Open www.signalhound.com in the system default web browser.
Support Forums - Open the signal hound support forum web page in the system default
web browser.

About Spike - Display version and product information for Spike and the device APIs.

3.3 THE CONTROL PANELS

The control panels are a collection of interface elements for configuring the device and configuring the
measurement utilities of the software. On first start up, a control panel will appear on both sides of the
graticule. Each control panel can be moved to accommodate a user’s preference. The panels may be
stacked vertically, dropped on top of each other (tabbed), or placed side by side. This can be
accomplished this by dragging the panels via the control panel’s title bar.

Each control panel contains multiple subsets of related controls. Each subset will be described in more
depth below. Each subset can be collapsed or expanded.

3.3.1 Measurements

The Measurements control panel allows the user to configure the spectrum related measurements. This
control panel is visible while the software is in standard swept analysis and real-time operating modes.

11
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3.3.1.1 Trace Controls

The software offers up to six configurable traces. All six traces can be customized and controlled through
the measurements control panel. When the software first launches only trace one is visible with a type of
Clear & Write.

e Trace - Select a trace. The trace controls will populate with the new selected trace. All
future actions will affect this trace.

¢ Type - The type control determines the behavior of the trace over a series of acquisitions.

o Off - Disables the current trace.

o Clear & Write - Continuously displays successive sweeps updating the trace fully
for each sweep.

o Max Hold - For each sweep collected only the maximum trace points are retained
and displayed.

o Min Hold - For each sweep collected only the minimum trace points are retained
and displayed.

o Min/Max Hold - For each sweep collected, the minimum and maximum points are
retained and displayed.

o Average - Averages successive sweeps. The number of sweeps to average together
is determined by the Avg Count setting.

e Avg Count - Change how many sweeps are averaged together when a trace type of
average is selected.

e Color - Change the color of the selected trace. The trace colors selected are saved when
the software is closed and restored the next time the software is launched.

e Update - If update is not checked, the selected trace remains visible but no longer updates
itself for each device sweep.

e Hidden - If checked, the selected trace will

e Clear - Reset the contents of the selected trace.

e Export - Save the contents of the selected trace to a CSV file. A file name must be chosen
before the file is saved. The CSV file stores (Frequency, Min Amplitude, Max Amplitude)
triplets. Frequency is in MHz, Min/Max are in dBm/mV depending on whether logarithmic
or linear units are selected.

3.3.1.2 Marker Controls

The software allows for six configurable markers. All six markers are configurable through the
measurements control panel.

e Marker - Select a marker. All marker actions taken will affect the current selected marker.

e Place On - Select which trace the selected marker will be placed on. If the trace selected
here is not active when a marker is placed, the next active trace will be used.

e Update - When Update is ON, the markers amplitude updates each sweep. When OFF, the
markers amplitude does not update unless moved.

e Active - Active determines whether the selected marker is visible. This is the main control
for disabling a marker.

12
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Set Freq - Manually place the marker on the selected trace at the selected frequency.
Enable the marker if it is currently disabled. The marker frequency will be rounded to the
closest available frequency bin.

Peak Search - This will place the selected marker on the highest amplitude signal on the
trace specified by Place On. If the selected trace is Off then the first enabled trace is used.
Delta - places a reference marker where the marker currently resides. Once placed,
measurements are made relative to the position of the reference point.

To Center Freq - changes the center frequency to the frequency location of the selected
marker.

To Ref Level - changes the reference level to the amplitude of the active marker.

Peak Left - If the selected marker is active, move the marker to the next peak on the left.
Peak Right - If the selected marker is active, move the marker to the next peak on the
right.

For peak left/right, peaks are defined by a group of frequency bins 1 standard deviation above the mean
amplitude of the sweep.

3.3.1.3 Offsets

Ref Offset - Adjust the displayed amplitude to compensate for an attenuator, probe, or
preamplifier. The offset is specified as a flat dB offset. This offset is applied immediately
after a sweep is received from the device, before any measurement is performed.

3.3.1.4 Sweep Trigger

Enabled - When checked, the sweep amplitude trigger is enabled.
Level - Specifies the threshold amplitude for the sweep amplitude trigger.

3.3.1.5 Channel Power

Width - Specify the width in Hz of the channels to measure.

Spacing - Specify the center-to-center spacing for each channel.

Enabled - When enabled, channel power and adjacent channel power measurements will
become active on the screen.

The adjacent and main channels are only displayed when the width and spacing specifies a channel
within the current span. See Taking Measurements: Measuring Channel Power for more information.

3.3.1.6 Occupied Bandwidth

Enabled - When enabled, occupied bandwidth measurements will become active on the
screen.

% Power - Percent power allows the percentage of the integrated power of the occupied
bandwidth measurement to be adjusted.

13
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3.3.2 Sweep Settings

The Sweep Settings control panel controls the sweep acquisition parameters for the device in standard
swept-analysis and real-time modes.

3.3.2.1 Frequency Controls

Center - Specify the center frequency of the sweep. If a change in center frequency causes
the start or stop frequencies to fall outside the range of operation, the span will be
reduced. Using the arrows changes the center frequency by step amount.

Span - Specify the frequency difference between the start and stop frequencies centered
on the center frequency. A reduced span will be chosen if the new span causes the start or
stop frequencies to fall outside the range of operation. Use the arrows to change the span
using a 1/2/5/10 sequence.

Start/Stop - Specify the start and stop frequency of the device. Frequencies cannot be
chosen that are outside the range of operation of the active device.

Step - Specify the step size of the arrows on the center frequency control.

Full Span - This will change the start, stop, center, and span frequencies to select the
largest span possible.

Zero Span - Enter Zero-Span mode, using the current center frequency as the starting
center frequency for zero-span captures.

3.3.2.2 Amplitude Controls

Ref Level - Changing the reference level sets the power level of the top graticule line. The
units selected will change which units are displayed throughout the entire system. When
automatic gain and attenuation are set (default), measurements can be made up to the
reference level. Use the arrows to change the reference level by the amount specified by
the Div setting.
Div - Specify the scale for the y-axis. It may be set to any positive value. The chosen value
represents the vertical height of one square on the graticule.

o Inlinear mode, the Div control is ignored, and the height of one square on the

graticule is 1/10" of the reference level.

Atten - Sets the internal electronic attenuator. By default the attenuation is set to
automatic. It is recommended to set the attenuation to automatic so that the device can
best optimize for dynamic range and compression when making measurements.
Gain - Gain is used to control the input RF level. Higher gains increase RF levels. When gain
is set to automatic, the best gain is chosen based on reference level, optimizing for dynamic
range. Selecting a gain other than Auto may cause the signal to clip well below the
reference level, and should be done by experienced Signal Hound users only.
Preamp - If the device connected has an internal preamplifier, this setting can be used to
control its state.

3.3.2.3 Bandwidth Controls

RBW Shape - Select the RBW filter shape. See RBW Filter Shape for more information.

14
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e RBW - This controls the resolution bandwidth (RBW). For each span a range of RBWs may
be used. The RBW controls the FFT size and signal processing, similar to selecting the IF
band pass filters on an analog spectrum analyzer. The selectable bandwidths displayed
change depending on the RBW Shape selected.

o Nuttall RBWs are available from below 1 Hz to 10.1 MHz, in powers of two. Use the
arrow buttons to move through the selectable RBWs.

o Flat-top and CISPR RBWs are available in a 1-3-10 sequence. (e.g. 1 kHz, 3 kHz, 10
kHz, 30 kHz, 100 kHz, ... ) when using the arrow keys.

e VBW - This controls the Video Bandwidth (VBW). After the signal has been passed through
the RBW filter, it is converted to an amplitude. This amplitude is then filtered by the Video
Bandwidth filter.

o Al RBW choices are available as Video Bandwidths, with the constraint that VBW
must be less than or equal to RBW.
o InReal-Time mode VBW is not selectable.

e Auto RBW - Having auto selected will choose reasonable and fast RBWs relative to the
span. When changing span, it is recommended to have this enabled along with Auto VBW.

e Auto VBW - When enabled, VBW will equal RBW.

3.3.2.4 Acquisition Controls

e Video Units - In the system, unprocessed amplitude data may be represented as voltage,
linear power, or logarithmic power. Select linear power for RMS power measurements.
Logarithmic power is closest to a traditional spectrum analyzer in log scale.

e Video Detector Settings - As the video data is being processed, the minimum, maximum,
and average amplitudes are being stored.

e Sweep Time

o For SA series devices, the sweep time value is ignored.

o For BB series devices, sweep time is used to suggest how long the spectrum
analyzer should acquire data for the particular configure sweep. The actual sweep
time may be significantly different from the time requested, depending on RBW,
VBW, and span settings, as well as hardware limitations.

3.3.3 Zero-Span Settings

The Zero-Span Settings control panels allows configuration of zero-span captures. It is only visible when
in Zero-Span mode.

3.3.3.1 Capture Settings

¢ Input Pwr - Expected input power of the signal. Input power controls the reference level
and the gain and attenuation. It is suggested to keep gain and attenuation set to Auto so
the software can best choose them based on the Input Pwr.

e Center - Specifies the tuned center frequency of the capture, or in another way, the OHz
frequency of the I/Q data capture.

e Gain - Controls the internal device amplification. It is recommended to keep this value set
to Auto.
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e Atten - Controls the internal device attenuation. It is recommended to keep this value set
to Auto.

e Decimation - Controls the overall decimation of the I/Q data capture. For example, a
decimation of 2 divides the receiver sample rate by 2. Increasing decimation rate increase
the possible capture time of the software but decreases the time resolution of each
capture.

¢ Sample Rate - Displays the sample rate of the current visible 1/Q data capture. This
number is equal to the device sample rate divided by the decimation value.

e IF BW - (Intermediate Frequency Bandwidth) Controls the bandwidth of the passband filter
applied to the 1Q data stream. The bandwidth cannot exceed the Nyquist frequency of the
I/Q data stream.

e Auto IFBW - When set to Auto, the IF Bandwidth passes the entire bandwidth of the 1/Q
data capture.

e Swp Time - (Sweep Time) Controls the length of the zero-span data capture. The length is
relative to the sample rate selected by decimation. Sweep times are clamped when the
resulting capture contains less than 20 samples, and at the upper end, when the resulting
capture contains more than 65536 samples.

3.3.3.2 Trigger Settings

e Trigger Type - Select a trigger type for the data capture. When a trigger type is selected,
the captures are synchronized by the presence of a trigger.

e Trigger Edge - Select whether to trigger on a rising or falling edge. Applies to both external
and video triggers.

e Video Trigger - Select the amplitude for the video trigger to trigger on. This value is
ignored if video triggering is not selected.

e Trigger Position - When a video or external trigger is selected, trigger position determines
what percentage of samples of the sweep are displayed before the trigger. For example, in
a 100 point sweep with a 10% trigger position, the sweep will display the 10 points before
the trigger occurrence, and the first 90 points after the trigger.

3.3.3.3 AM/FM Modulation Analysis

e Enabled - Enables the modulation analysis display.
e Low Pass - Set the audio filter cutoff frequency.

See Taking Measurements: AM/FM Modulation Analysis for more information.

3.3.4 Scalar Network Analysis Control Panel

This control panel appears when the operational mode has been changed to “Scalar Network Analysis”.
This control panel will only appear if a spectrum analyzer and tracking generator are both present and
the software is able to begin the tracking generator sweeps. The control panel will appear at the top of
the Sweep Settings control panel.

e Sweep Size - Specify a suggested sweep size. The final sweep size is affected by this
suggestion as well as hardware limitations.
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Sweep Type - Specify whether and active or passive device is being swept. This will affect
the attenuation and gain used during the sweep. Failing to properly set this value may
result in reduced dynamic range or IF overload.

High Range - If high range is selected, the software will optimize the sweep for dynamic
range when a 20dB pad store through is performed. Sweep speed will increase when
unselected at a penalty of lower dynamic range.

Plot VSWR - Plot the return loss as VSWR.

VSWR Div - Specify the vertical plot divisions. When VSWR is being plotted, the graticule
ranges from 1.0 at the bottom of the plot, to 1.0 + 10 * div at the top.

Store Thru - Press this button to normalize the sweep on the next acquired sweep. This
may be re-pressed in the event a poor normalization occurred.

Store 20dB Pad - Perform a normalization when a 20dB pad is inserted in the RF path.
Should only be performed after a normal “Store Thru".

For more information on these controls see Modes of Operation : Scalar Network Analyzer

3.3.5 Digital Demodulation Control Panel
3.3.5.1 Demod Settings

Center Freq - Specify the carrier frequency of the modulated signal.

Input Power - Specify the maximum expected input power of the input signal. Ideally this value
should be set to ~10 dB above the input power for the best dynamic range and resulting
measurements.

Sample Rate - Specify the symbol rate of the modulated input signal.

Symbol Count - Specify the number of symbols to plot.

Modulation - Specify the modulation format of the input signal.

Meas Filter - Specify the filtering to be performed by the demodulator. See Selecting the
Measurement Filter for more information.

Filter Alpha - Specify the bandwidth coefficient of the measurement filter. See Selecting the
Measurement Filter for more information.

Auto IF Bandwidth - Specify whether the software selects an IF bandwidth automatically based
on configuration. If automatic bandwidth is selected, the bandwidth is chosen as 2 times the
symbol rate.

IF Bandwidth - Specify the width of an IF bandwidth filter to be applied before demodulation.
This filter is used to reject out of band interference or adjacent channels.

1/Q Inversion - Specify whether to swap I/Q channels before demodulation occurs.

Average Count - Select the average count for the modulation quality metrics on the error
summary panel.

3.3.5.2 Trigger Settings

Trigger Type - Specify whether to trigger the capture on sync pattern.

Pattern(Hex) - Specify a sync pattern to trigger on.

Pattern Length - Specify the number of symbols in the sync pattern. The pattern bits are
specified in the Pattern entry. If the number of bits in the pattern entry are greater than the
number of bits necessary to meet the length specified, then the least significant bits are used. If
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the pattern is shorter than the length specified, then the pattern is padded with zeros to reach
the number of symbols specified.

Search Length - Specify the size of the search window in symbols. The pattern will be searched
for within this window.

3.3.6 Recording Control Panel

The playback toolbar controls the recording and playback of sessions. Sessions are a collection of saved

sweeps

Inactive

at one device setting. See Taking Measurements: Saving Sessions.
® B b HE Il « 4 M

Folder Select - Change the directory files are saved to and which directory is opened when
Record - Begins recording a session

Stop Recording - Stops recording an active session.

Play/Continue - Begin playing a saved session or continue a paused session.

Stop - Stop playing the current session.

Pause - Pause the current session.

Rewind - Rewinds then pauses the session.

Step Back - Shows the previous trace in the session and pauses.

Step Forward - Shows the next trace in the session and pauses.

3.3.7 Frequency Mask Trigger Control Panel

The frequency mask trigger control panel contains controls for managing trigger masks and sweep video
triggers. A screen shot of the panel and description of each control are listed below.

Frequency Mask Trigger

Enabled

Trigger Type | Amplitude Level -

Level

O Frequency (MHz) | Amplitude (dBrm) Add Row |

99875 I Delete Selected Rows |
998.9 -40
999 -40

Import Mask 10011 -40

1001.25 -85

[2]w]n]eT]o

|
Save Mask |

| Record || Mask Trigger |

Figure 2: Frequency Mask Trigger Control Panel

Enabled - Enables and disables the triggering.

Trigger Type - Specify which type of frequency triggering is performed. When “Amplitude
Level” is enabled, the spectrum is compared against a single amplitude value specified by
the Level setting. When ‘Frequency Mask' is selected, the table is used as a frequency mask.
Level - Controls the video trigger level when a trigger type of “Amplitude Level” is selected.
Import Mask - Allows the user to supply a custom mask in the form of a CSV file. The
contents are imported and displayed in the table.

Save Mask - Output a CSV file of the current contents of the mask table.

Add/Delete Row - Append a new row to the end of the table or delete the current
highlighted row.
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3.4 THE TOOL BARS

The tool bar is located under the application menu. The toolbar is populated with commonly used
functionality and view related controls for the current software configuration. The common tool bars and
available controls are described in the following sections.

3.4.1 Sweep Toolbar

The sweep toolbar is visible when the device is operating in the normal sweep and real-time modes. The
toolbar is located above the graticule and contains controls for displaying and controlling traces.

e Spectrogram - Enables the display of two and three dimensional spectrogram displays.
See Display Modes: Spectrogram.

e Persistence - Enables/disables the persistence display. See Display Modes: Persistence.

e Clear - Clear the contents of the persistence display.

¢ Intensity - Controls the intensity of the persistence display.

e Single - Request the software perform one more sweep before pausing.

e Continuous - Request that the software continuously retrieves sweeps from the device.

e Preset - Restores the software and hardware to its initial power-on state by performing a
device master reset.

3.4.2 Zero-Span Toolbar

The zero-span toolbar is visible when the device is operating in zero-span mode. The toolbar is located
below the file menu and contains controls for manipulating the displays and controlling acquisitions.

¢ Demod Selection - Specify which analog demodulation to perform and display. Choices
include amplitude, frequency, and phase demodulation.

e Marker Off - Disables an active marker on the waveform.

e Marker Delta - Toggles the delta marker on the waveform.

e Single - Request the software to perform a capture and pause the display. If a video or
external trigger is configured, the software will continue to update until a trigger is found.

e Auto - Request the software continuously update with the specified trigger.

e Preset - Restores the software and hardware to its initial power-on state by performing a
device master reset.

3.4.3 Digital Demodulation Toolbar

The digital demodulation toolbar is visible when the software has entered the modulation analysis
mode. This toolbar provides a number of controls to help the user customize the view layout.

e Add View - This control allows a user to add to the view area one of many default data
views.
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e Auto Fit - When Auto Fit is selected the visible views will be auto scaled to fit the available
application space. Disabling Auto Fit allows a user to scale and move the views into a
custom configuration without the software interfering.

¢ Reset View - Resets the view area to the default configuration.

3.5 PREFERENCES

The preferences menu can be found under Edit Menu >Preferences. The preferences menu contains a
collection of settings to further configure the Spike™ software.

e Trace Width - Determines to overall width of the trace being drawn on the graticule.

e Graticule Width - Determines the width of the lines that make up the graticule.

e Graticule Dotted - Set whether the non-border graticule lines are dotted or solid.

e Feature Colors - Control the color of various software features.

e Sweep Delay - Set a delay which occurs after each device sweep. This delay can be used to
artificially slow down the rate of sweeps, which can reduce overall processor usage and
increase the length of time a recording covers.

e Real Time Frame Rate - Set the update rate of the device and software when operating in
real-time mode. Higher frame rates improve the resolution of events but also require
higher PC performance. Can set values between 4 and 30 fps.

e Playback Sweep Delay - Set how fast the sweeps are played back from a recorded sweep
file. The delay is incurred between each displayed sweep.

¢ Max Save File Size - Control the maximum size of a sweep recording. The software will
stop recording when the max file size has been reached. For 32-bit machines, 1GB is the
maximum possible file size. On 64-bit machines, the max file size can be set to 128GB.

3.5.1 Language Selection

The Spike software offers multiple language choices for the majority of user facing text and strings. The
first time the software is launched on a PC, Spike will attempt to determine the best translation based on
locale. Once loaded Spike will remember the last language used.

In the preference menu, a user can change the translation Spike uses. Simply select the language of
choice and press “Apply”. Once applied, the software will need to be restarted to take effect. On the next
program launch the selected language will be loaded.

3.6 THE STATUS BAR

The status bar runs across the bottom of the application. When the mouse enters the graticule the
status bar displays the frequency/time value for the x-axis and the amplitude/frequency value for the y-
axis. The status bar readings should not be used for precise measurements, but is great for quick
estimations.
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The status bar also displays information about the current device connected if there is one. The type of
device, temperature of the device, power supplied to the device, the device serial number and firmware
version are displayed.

3.7 ANNUNCIATOR LIST

On the upper left hand corner of the graticule, a list of annunciators can be displayed. Annunciators are
warnings and indicators providing useful information to the operator. Below is a list of all annunciators
and their meanings.

e IF Overload - This indicator appears when hard compression is present on the displayed
sweep. This annunciator will appear in the top center of the graticule and will trigger the
UNCAL indicator. This occurs when the input RF signal reaches the maximum possible
digital level. To fix this, decrease input signal amplitude, increase the reference level,
increase attenuation, or lower gain.

e USB - This indicator appears when data loss occurred over USB resulting in the failure to
acquire the sweep. The software will continue to attempt to acquire sweeps in this scenario
until a full sweep can be retrieved. If you see this message regularly, this is an indication of
potential PC problems, such as out of date drivers, faulty USB hardware, or over-taxed
system. This message will only appear for BB60C device with firmware version 7 or greater.

e TEMP - This indicator appears when the device has deviated more than 2 °C since its last
temperature calibration. The software will automatically calibrate if the device is not in real-
time mode. Manually recalibrate the device by changing sweep parameters such as
frequency range, or ref level, etc.

e LOWYV - This indicator appears when the device is not receiving enough voltage from the
USB 3.0 connection. The voltage value appears when this annunciator is present. The
device requires 4.4V. If this annunciator appears, it may indicate other problems. Contact
Signal Hound if you are unable to determine the source of this problem.

e UNCAL - This indicator appears whenever any warning indicator is active to notify the user
that the device may not be meeting published specifications.

3.8 I/Q RECORDING TOOLBAR

In Zero-Span mode, the I/Q recording toolbar is located below the graticule displays. The toolbar
contains a number of controls for configuring and capturing I/Q waveforms. See Taking Measurements:
I/Q Recording for more information.

Record Directory Browse C:/Users/AdiDocuments/SignalHound!  Record Length{ms) 1.000 Save as  Binary - Record

¢ Record Directory - Specify the storage directory for all saved I/Q captures. The default location
is the current users Documents folder.

e Record Length - Specify the duration of the recording. Recording lengths can be specified
between 1 millisecond and 1 second.

e Save As - Specify the file format as either binary or text based.

e Record - Perform one capture.
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4 Modes of Operation

The Spike™ software allows the Signal Hound spectrum analyzers to operate in multiple modes of
operation. Common modes of operation available to all Signal Hound devices include swept analysis,
real-time spectrum analysis, scalar network analysis (with a Signal Hound tracking generator), and zero-
span. Other possible modes which are device specific include harmonic analysis, phase noise
measurements, and digital demodulation.

All Signal Hound spectrum analyzers are real-time devices. This means the device is capable of
continuously streaming the IF frequency with no time gaps. Having no time gaps is critical for
measurements and tests requiring high probability of intercept (POI). See Real-Time Spectrum Analysis
for a more in-depth discussion of the real-time device capabilities.

4.1 SWEPT ANALYSIS

This mode of operation is the mode which is commonly associated with spectrum analyzers. Through
the software you will configure the device and request the device perform a single sweep across your
desired span. Spans larger than the devices instantaneous bandwidth are the result of acquiring multiple
IF patches and concatenating the results of the FFT processing on each of these IFs.

The processing performed on each IF patch is determined by the settings provided. Each time a trace is
returned, the device waits until the next trace request. For you, the software user, you can choose to
continuously retrieve traces or manually request them one at a time with the Single and Continuous
buttons found on the Sweep Toolbar.

4.2 REAL-TIME SPECTRUM ANALYSIS

All Signal Hound spectrum analyzers can function as online real-time spectrum analyzers. The Spike
software exposes this functionality for each spectrum analyzer. Real-time spectrum analysis can be
performed by selecting Analysis Mode -> Real Time in the main file menu. When the device is in real-time
analysis mode, the bandwidth is limited to the real-time bandwidth, which is different for each Signal
Hound device.

Analyzing signals in real-time mode is critical | Device Real-Time Bandwidth
for characterizing short duration spectral

events, such as spurious emissions or for SA44/5A124 250kHz

interference hunting. Real-time analysis is BB6OA >0MHz

also great for monitoring spread spectrum

signals and observing frequency hopping | BB60C 27MHz

communications channels.

Max Real-Time Bandwidth
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These types of applications are possible because real-time spectrum analysis guarantees 100%
probability of intercept for signals of a specific duration. That duration is dependent on the Signal Hound
spectrum analyzer and the resolution bandwidth. Any signal that exceeds that duration is guaranteed to
captured and displayed by the Spike software.

When in real-time mode, a special persistence display is shown. A screen shot of the software in real-
time mode is shown below.
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Figure 3: SA44B analyzing an FM radio station in real-time spectrum analysis mode. The persistence display is shown on the bottom half of the
application and a 2-dimensional waterfall plot is shown on top.

The persistence display shows a three dimensional view of the signal density in the given span, where
the X and Y axis still show amplitude over frequency, while the color of the plot is the density of the
spectrum at any given point. As the spectrum density increases at a given point, the color of the plot will
change from blue to green to red. The Signal Hound spectrum analyzers are capable of creating these
plots from thousands to over a million traces worth of data per second to create these complex displays
(depends on RBW). The persistence display is the accumulation of roughly 2/3 of a second of real-time
data acquisition.

4.3 ZERO-SPAN ANALYSIS

Zero span analysis allows a user to view and analyze complex signals in the time domain. The application
can demodulate AM, FM, and PM modulation schemes, and display the results through multiple plots. A
user can enter zero span mode by using the Analysis Mode drop down file menu, or by pressing the zero
span button on the Sweep Settings control panel. Below is an image of the software operating in Zero-
Span mode.
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Figure 4: Zero Span Analysis View

The application window will be split into multiple viewports and contain a control panel for controlling
zero span sweeps. Zero span mode offers three viewports,

1. Demodulation Waveform Plot - Shows the results of performing AM/FM/PM demodulation. The
waveform is plotted as Amplitude/Frequency/Phase over time depending on the modulation
type selected.

2. Spectrum Plot - Shows the frequency spectrum of the zero span capture. The plot shows the
amplitude over frequency of the waveform signal.

3. 1/Q Waveform Plot - Plots the individual | and Q channels as amplitude over time.

The control panel contains inputs for controlling the capture settings of the device as well as specifying
trigger conditions for the zero span sweeps. Available triggers are video and external. Video triggers
begin the sweep only after a signal exceeds the amplitude specified in the Video Trigger input. This is
useful for analyzing a periodic transmission.

If the transmitter has a trigger output, the trigger can be routed to the spectrum analyzer trigger input.
Select “external trigger” to cause the zero-span sweep to begin after the hardware trigger. The trigger can
occur on the rising or falling edge of a signal. A 3.3V CMOS trigger with a 50 ohm output impedance is
ideal, but 5V logic with a 50 ohm output impedance is acceptable. Higher or lower output impedance
may work with a short BNC cable, but longer cables may cause issues with reflection.

If the trigger output is sensitive to loading, start zero span mode with external trigger enabled before
connecting the trigger, to ensure the trigger port is configured as an input.
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4.4 SCALAR NETWORK ANALYZER

If a BB or SA-series spectrum analyzer and tracking generator are both connected to the PC, select
Analysis Mode > Scalar Network Analysis in the file menu. Scalar network analysis is used to measure the
insertion loss of a device such as a filter, attenuator, or amplifier across a range of frequencies. This
mode, when used with a directional coupler, also measures return loss.
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Figure 5 The Spike™ software and a SA44B and TG44A sweeping an inline passive bandpass filter.

To learn more about scalar network analysis and how the Signal Hound devices perform this task, please
refer to the Signal Hound Tracking Generator user manual.

Ensure the TG sync port on the tracking generator is connected to the Sync Out port on the SA series
spectrum analyzer.

ic i 4 Tracking Generaty
When Scalar Network Analys|s is selected, an

additional control panel is added to the Sweep Setting  Sweep Size | 100.000 | pts
control panel. Sweep Type | Passive Device v|
High Range

This control panel exposes additional controls for

configuring network analyzer sweeps. ‘ N ” Store 2008 Pad |

4.4.1 Configuring Scalar Network Analyzer Sweeps

The controls for Frequency, Amplitude, and Tracking Generator are used to configure sweeps, as follows:
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Use the Frequency controls to configure the desired center frequency and span.
o For most devices, a start frequency of >250 kHz and a span of >100 kHz is
recommended. This maximizes dynamic range, sweep speed, and accuracy.
o  (SA44/SA124 only) For crystals or other very high Q circuits with a bandwidth of 50
Hz to 10 kHz, select a span of 100 kHz or less. A slower narrow-band mode will be
automatically selected. In this mode, a 100 point sweep takes about 7 seconds, but
the sweep updates at each point.
Use the Amplitude controls to set the Reference Level, typically to +10 dBm.
Using the Tracking Generator Controls:
o Select the desired sweep size. A 100 point sweep is a good starting point.
o If measuring an amplifier, select Active Device
o Leave High Range checked unless faster sweeps are needed at the expense of
dynamic range.
o If accurate measurements are needed below -45 dB, use the default settings of
Passive Device and High Range.

4.4.2 Performing Sweeps

Before accurate measurements can be made, the software must establish a baseline, something to call 0
dB insertion loss. In the Spike software, this is accomplished by clicking Store Thru.

1.

Connect the tracking generator RF output to the spectrum analyzer RF input. This can be
accomplished using the included SMA to SMA adapter, or anything else the user wants the
software to establish as the 0 dB reference (e.g. the 0 dB setting on a step attenuator, or a 20 dB
attenuator in an amplifier test setup).

Click Store Thru and wait for the sweep to complete. The sweep should be normalized at 0 dB
when this process completes. At this point, readings from 0 dB to approximately -45 dB are
calibrated.

(Optional) If accurate measurements are needed below -45 dB, insert a fixed SMA attenuator,
and then click Store 20 dB Pad. The actual attenuation value does not matter, but it must
attenuate the signal from the TG by at least 16 dB and not more than 32 dB. This corrects for any
offsets between the high range and low range sweeps, giving accurate measurements down to
the noise floor.

Insert the device under test (DUT) between the tracking generator and the spectrum analyzer
and take measurements. All traces and markers are accessible during the network analyzer
sweeps.

Note: Changing the sweep settings (frequency, amplitude, etc.) will require repeating steps 1-4.

4.4.2.1 Improving Accuracy

One shortcoming of the Signal Hound tracking generators is poor VSWR / return loss performance.
However, this can be easily overcome by adding good 3 dB or 6 dB pads (fixed SMA attenuators) to the
output of the tracking generator and / or the input of the spectrum analyzer. A good 6 dB pad will
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improve return loss by nominally 12 dB to >20 dB, and should enable accurate measurements. These
may be included when sweeping the "thru," effectively nulling them out. This will decrease the overall
dynamic range.

4.4.2.2 Testing High Gain Amplifiers

When measuring an amplifier that will have gain of 20 to 40 dB, the use of a 20 dB pad is required.
Simply insert the 20 dB pad before the Store Thru, and leave the pad on either the SA or TG when
connecting to the amplifier. For amplifiers with more than +20 dBm maximum output, the pad should go
on the output of the amplifier. If an amplifier cannot safely handle -5 dBm, place the pad on the
amplifier's input.

4.4.3 Measuring Return Loss

A directional coupler of appropriate frequency range (sold separately) may be used to make return loss
measurements.

e Connect the tracking generator to the directional coupler's "OUT" port.

e Connect the spectrum analyzer to the directional coupler's "COUPLED" port.

e Use the "IN" port as the test port. Leave it open (reflecting 100% of power).

e If a cable will be used between the test port and the antenna, connect it to the IN port but
leave the other end of the cable open.

e Click Store Thru. The sweep should be normalized to 0 dB.

e Connect the device under test (e.g. antenna) to the "IN" port or cable. Return loss will be
plotted.

Once again, measurement accuracy will benefit from 3 to 6 dB pads on the Signal Hound devices prior to
Store Thru. This method is not as accurate as using a precision vector network analyzer, but with a good
directional coupler, accuracy within a few tenths of a dB is typical.

4.4.3.1 Adjusting an Antenna

To adjust an antenna for a certain frequency, use the Return Loss setup, above. Lengthen, shorten, and
tweak impedance matching elements until the desired return loss is achieved. Be aware that you will be
radiating some RF during this process. It is your responsibility to understand and obey laws regarding
transmitting on those frequencies.

4.4.4 Manual Tracking Generator Sweeps

To test devices with bandwidths below 50 Hz (e.g. 60 Hz notch filter), or if more than 90 dB of dynamic
range is needed, do not use Scalar Network Analysis mode. Instead, stay in Swept Analysis mode and
use Utilities>Tracking Generator Controls to set the tracking generator to a CW frequency output.
Use Peak Search and Delta to establish relative amplitude, then insert the DUT and manually tune the TG
across a narrow range of frequencies. A TG output of -10 dBm combined with an RBW of 10 Hz should
give around 130 dB of dynamic range for most frequencies. Care must be taken in cable and device
placement to avoid crosstalk.
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4.5 DIGITAL DEMODULATION

By utilizing the digital demodulation capabilities of the Spike software, a Signal Hound spectrum analyzer
can function as a vector signal analyzer (VSA). This allows a user to measure signals that cannot be
described in terms of AM or FM. With the spike software it is possible to characterize a number of
complex communications signals. The Spike software offers a number of common VSA views, such as
constellation diagrams, symbol error charts, and symbol tables.

The Spike software allows the demodulation of a number of modulation schemes such as BPSK, DBPSK,
QPSK, DQPSK, 8PSK, D8PSK, /4DQPSK, OQPSK, and QAM16, N-FSK, and ASK. See the symbol mappings
for each of the supported schemes in the Appendix: Constellation Mappings.

Digital demodulation can be accessed through the Analysis Mode -> Modulation Analysis file menu
setting. The picture below is an image of the software operating in this mode.
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>Figure 6: The SA44B demodulating a Pi/4QPSK signal

4.5.7 Customizing the Display

Spike allows a user to add and organize a number of measurement displays. The displays can be added
to the main view area by selecting the “Add View” combo box on the toolbar and selecting from a
number of default displays. If “Auto Fit" is enabled, the view is added to an organized grid of views. If
Auto Fit is disabled then the user can move and resize the view to their liking. The view organization is
saved when the application is closed and restored on the next program invocation.
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4.5.1.1 Error Summary

The Spike software provides an error summary read-out which displays a number of modulation quality
metrics such as error vector magnitude (EVM), phase error, magnitude error, and frequency error. These
error values are used to measure signal characteristics and quality. Most error values are provided as a
peak and RMS average value taken over a sample size chosen by the user. The error value is first
averaged over the capture interval at each symbol, and then peak held and RMS averaged to generate

the displayed values. For peak symbol error values over a

Q single capture, see the Error vs Time plots.

Error Vector A number of modulation quality metrics are described
\ below.
Measured Vector 5
< Magnitude Error EVM is a common way to measure the quality of a
communication system. EVM is defined as the root mean
z square (RMS) of the error vectors. It is calculated in the
Reference Vector Sp|ke software as
Phase Error I
1 n-1 I 2 2
Figure 7: Visualization of the EVM, Magnitude and Phase NZO (error + Qerror )
Error Calculations %EVM = *100%

Normalization Reference

Magnitude error is defined as

_ |Magreference [n] | - |Magmeasured [Tl] |
Normalization Reference

Magnitude Error[n]

for each symbol. The RMS average and peak are calculated using all magnitude measurement errors for
the given capture window.

Phase Error is defined as
Phase Error[n] = Anglereference [n] — Anglepeqasyrea ]

FSK Error is defined as

RMS(FSK Error at each symbol)
Deviation

FSK Error =

where the error at each symbol is
FSK Error at Symbol i = FSK Measured[i] — FSK Reference|i]
and deviation is the peak frequency deviation.

Frequency Error is defined as the difference between the reference carrier frequency and measured
carrier frequency, where the reference frequency is the user supplied center frequency.
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The Spike software uses a normalization reference of one. This is defined as the value of the maximum
constellation magnitude. The Spike software forces the largest constellation magnitude to be one for
each of the selectable modulations.

4.5.1.2 Constellation Diagram

QAM16 Ref -30.000 dBm

1.60 [Vedurs and Points v

-1.60

-1.75 1.75
Figure 8: Constellation Diagram for a QAM 16 Input Signal

The constellation diagram helps a user visualize the quality of the signal and identify signal impairments
such as phase noise, amplitude imbalance, and quadrature error. The constellation plot displays the
modulation states and transitions of the input signal in the complex plane.

4.5.1.3 Symbol Table

The symbol table displays the demodulated bits of the input signal. The number of bits shown is equal to
the symbol count selected times the number bits each symbol represents for the modulation type
selected. The bits can be displayed in binary or hexadecimal format.

The symbol table will also display the trigger pattern and whether or not it was detected.

30



-Modes of Operation | bigital Demodulation

4.5.1.4 Eye Diagram

E Eye Diagram

16

-16

| Channel

-1 Sym | +1 Sym

Figure 9: Eye diagram for a Pi/4DQPSK signal

Q Channel

Spike allows the addition of an eye diagram display in modulation analysis mode. The eye diagram is
used to visualize a number of system performance characteristics, such as signal distortion, inter-symbol
interference, signal-to-noise, and timing errors.

4.5.1.5 Error vs Time

Spike allows the addition of a number of error over time displays. These displays offer a symbol
resolution view of the common quality metrics such as EVM, magnitude error, and phase error. Below is
the EVM vs Time plot, displaying individual EVM error over all symbols in the configured capture.

TN BV vs Time

10
%

Yo

=8

EVM vs Time

5.59 % Peak Ermr

Figure 10: EVM vs Time plot
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4.5.2 Selecting the Measurement Filter

It is possible to specify a baseband filter to be applied to the received data. Specifying the correct filter is
necessary to demodulate the system under test. Below is a table of the possible configurations that the
software provide.

If the transmitter filter is: And the receiver filter is: Then the measurement filter
should be:

Raised Cosine None Raised Cosine

Root Raised Cosine Root Raised Cosine Root Raised Cosine

Gaussian None Gaussian

A user must also select the filter bandwidth, sometimes referred to as the filter alpha. If the
measurement filter is root raised cosine, then the filter alpha of the transmitter filter must be provided to
produce accurate demodulation.

5 Taking Measurements

This section helps a user learn how to measure, analyze, and record signals using the Spike™ software,
utilizing built-in features such as markers, record/playback, and channel power.

5.1 MEASURING FREQUENCY AND AMPLITUDE
5.1.1 Using Markers

The software has several tools for identifying a signal's frequency and amplitude. The easiest to use is
the marker. There are 6 markers available, each with its own reference.

To activate and place a marker left click inside the graticule or press the Peak Search button on the
marker controls to place the marker on the current trace peak and activate it simultaneously. Once a
marker is active the frequency and amplitude readout of the marker is located in the top right of the
graticule. The marker's accuracy is dependent on the span and RBW. Narrower spans and RBWs have
higher marker accuracy. The amplitude accuracy is NOT dependent on the vertical dB/div, since the I/Q
data is linear in voltage and has much higher resolution than is displayed. The marker may be re-placed
at any time by clicking the graticule or by using the left and right arrows to shift the marker one sample
point to the left or right.

5.1.2 Using the Delta Marker

To measure differences or changes in frequency and/or amplitude use the Delta markers. To use the
delta markers first create a reference point. With a marker active click the Delta button on the
marker/trace control panel. This places a reference location on the graticule. Now the marker readings
will report the difference between the marker and the reference.
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5.1.3 Measuring Low Level Signals

To measure low-level signals, there are a few tricks to getting accurate readings. First, set the reference
level to -50 dBm or lower. This internally selects the highest sensitivity settings. Using an external time
base and narrow span (1 KHz or less) should give the best results. Video averaging may be required for a
stable amplitude reading.

5.2 SAVING SESSIONS

The playback toolbar allows a user to record and replay a continuous session up to the file size set in
Preferences > Max Save File Size. The length in time of the session will be dependent on the average
sweep speed of the session and trace length. Sessions files are named based on the current time and
date. This naming scheme ensures no files are overwritten and relieves a user of determining file names
when a user wants to capture a signal immediately. Pressing record on the playback tool bar causes the
software to immediately begin recording. All playback files are saved in the “My Documents”
folder(default) with the .bbr file extension.

When replaying a saved session, all functionality of the software remains, such as markers, min/max/avg
traces, persistence and spectrogram views. In addition the playback toolbar allows a user to pause, step,
and rewind through a saved session, using the slider bar as well as various control buttons.

Tip: The title is also recorded and shown
during playback. Use a title to describe the
session!

>/\ L5
5.3 1/Q CAPTURES

In Zero-Span mode, a user can save a short duration I/Q capture. I/Q captures can be recorded in binary
format or in a text based format such as CSV. This is useful for viewing captures in other analysis
programs such as Labview®, Matlab®, Excel®, or a custom program.

I/Q captures are performed in zero-span mode using the 1/Q recording toolbar located below the zero-
span graticule displays. A user can configure aspects of the capture such as the save directory, the
recording length and recording type.

The 1/Q capture files will be named as the current date and time. This is to prevent any capture from
overwriting another. Two files are saved for each capture, an XML file which describes the capture
settings, and either a binary or CSV file. When saving in binary, alternating I/Q samples are saved directly
as 32 bit values. When saving as text, a CSV file contains the alternating I/Q samples. Binary files are
more space efficient and require less time to save to a hard drive, but text files offer more convenience.
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An 1/Q capture begins when the record button is pressed on the toolbar. The capture follows the current
triggering rules. Therefore if a video trigger is set up, the capture will not occur until a video trigger
occurs. If the software is currently triggered and not updating when record is pressed, the software will
arm the trigger once more.

I/Q captures can be as short as 1 millisecond and as long as 1 second. Text based recordings at full
bandwidths can take many minutes to record.

5.4 CAPTURING SIGNALS OF INTEREST

CSV files can be created of traces with the Trace Export button found on the control panel. CSV files are
useful for performing further signal analysis or plotting outside the Signal Hound application. When
exporting a trace into a CSV file, the currently shown trace is exported. Because of this it may be difficult
to obtain a CSV file of a signal of interest. For example, an intermittent signal which appears sporadically
may be difficult to capture, or some modes such as Real-Time signal analysis are prohibited from saving
CSV files.

One way to export a desired signal is to record the spectrum using the playback toolbar. After capturing
a signal via recording, the session can be played back and paused on the signal of interest. From there,
the signal can be exported or measured through standard means.

Min and Max hold traces are another way to capture intermittent hard to view signals. Min and max hold
keep track of the minimum and maximum values over a period of time storing them in a separate
viewable trace.

5.5 MEASURING CHANNEL POWER

Channel power can be enabled from the control panel. Channel width specifies in Hz the width of the
band to measure. Channel spacing refers to the center-to-center frequency difference between the
center channel and adjacent channels. Between channels, there is typically (but not always) a small
guard band whose power is ignored.

For example, the image below shows a channel bandwidth of 180 kHz and spacing of 200 kHz. The
image shows the FM station 101.1 in the center channel. Each channel will be integrated and the
resulting power is display at the top of the channel.

The adjacent channels also show the channel power as well as the difference in power between the
center channel and itself. In the example below the difference might be used to determine if any power
is “leaking” into an adjacent FM band.
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VBW 771 Hz 4 1 ¢
Int Ref

-110.00

Figure 11: Channel Power on a Broadcast FM Signal

For best results, set the video processing to AVERAGE, POWER, and turn spur reject off. The software will
throw a warning if the settings are not configured properly when activating channel power.

5.6 RBW FILTER SHAPE

Selecting the RBW filter shape affects how the spectrum analyzer achieves the desired RBW. Different
shapes affect which window function is used and how the bandwidth is defined. Not all shapes are
available for all devices or in all modes. Here is a short description of the filter shapes Signal Hound
provides.

Flat Top - When this shape is selected, a variable bandwidth flat top window defined at the 3dB point is
used to achieve the desired RBW. The flat top window is selected by default and is recommended for the
most accurate measurements as it has very low scalloping loss.

Nuttall - When Nuttall is selected, the analyzer uses a fixed bandwidth Nuttall window defined at the
3dB point and powers of two FFTs to achieve discrete RBW values. When Nuttall is selected, all entered
RBW values will be clamped to these discrete values. Nuttall windows offer the fastest sweeps with the
lowest number of points in the sweep to achieve the RBW selected. The downside of the Nuttall shape is
the high scalloping loss at around 0.8 dB.

CISPR - When CISPR is selected, the analyzer uses a Gaussian window defined at the 6dB bandwidth
point and zero padding to achieve the selected RBW. This shape is commonly used for EMC/EMI pre-
compliance measurements.
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5.7 AM/FM MODULATION ANALYSIS

The Spike™ software is capable of performing analysis on AM and FM modulated audio. To perform
audio analysis the device must be operating in Zero-Span mode, and can be enabled on the control
panel. When enabled the device will be configured properly and a measurement readout will appear in

conjunction with the zero-span display plots.

Ref 156.250000 kHz

20.971520 ms per div

020 : : :
IF Bandwidth 100.000000 kHz

: : AM/FM Modulation Analysis
QA QF Conter 462.567525 Wiz
FM RMS: 8.438988 kHz. AM RMS 0.165%
FM Peak+: 12.025021 kHz AM Peak+ 0.681%
0.06M| FM Peak-: -12.027632 kHz AM Peak--0.580%
FM Rate: 999.998136 Hz AM Rate 5.373584 kHz
FM SINAD 49.21 dB
FM THD 0.07 %
-0.06M
-0.12M
Center 462 587500 MHz 65536 pts
0.00 Div 10 dB FFT Size 4096 pts Sample Rate 0.3125 MS/s
-20.00
-60.00
8000t
-100.00 3 L
Center 462.587500 MHz

Span 312.500 kHz Capture Len 0.209715s

Figure 12: Zero Span View with Audio Modulation Analysis
The modulation analysis utility performs a number of basic measurements on an audio signal such as:

e RF Center records the carrier frequency.

e Peak (+/-) records the minimum and maximum peak of the audio signal, recorded in Hz for
FM and depth% for AM

e RMS records the root mean square of modulation. RMS is displayed as Hz for FM and
depth% for AM.

¢ Modulation Rate records the frequency of the AM/FM modulation.

e SINAD (Signal-to-Noise And Distortion ration) records the signal quality defined by the
function

Psignal + Pnoise + Pdistortion
SINAD =

Pnoise + Pdistortion
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THD (Total Harmonic Distortion) records the presence of harmonic distortion in the audio signal as
defined by the function

JVE+ VE+-t+ V2

THD =
V1

or in words, the RMS of the first four hamonics to the RMS of the fundamental frequency.

Both SINAD and THD measurements occur for AM or FM depending on which demodulation type is
selected for Zero-Span.

A configurable low pass filter is available on the control panel. The low pass filter is applied to the audio
signal before modulation analysis is performed.

5.8 USING THE MEASURING RECEIVER UTILITY

The Spike™ software provides the functionality of a measuring receiver to make tuned RF level
measurements (TRFL). TRFL measurements are useful for characterizing attenuators, signal generators,
or any device on which a user wants to measure the accuracy of incremental steps in the output power.

TRFL measurements are capable of making more accurate power level readings and carrier frequency
readings than in standard swept analysis mode and is capable of measuring power to much lower levels
than in swept mode.

The measuring receiver utility can be accessed through File Menu > Utility - Measuring Utility. Enabling
the utility will bring up the dialog box shown below.
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22 Measuring Receiver I. 2 ﬁ]

Synchronous Level Detector

Center Freqg 50.000000 MHz

Amplitude Range
W High Power Range
[ ] Mid Power Range
[ ] Low PowerRange

RF Frequency 50.000003 MHz
RF Power -10.211 dBm
Relative Power -9.992 dB
Average Relative Power -9.987 dB
Sync Dane

Figure 13: Measuring Receiver Control Dialog

5.8.1 Measurement Procedure

This section outlines the procedure for making TRFL measurements with the measuring receiver utility.

1. With the Signal Hound device connected to the PC and application software running, select
Measuring Receiver from the Utilities file menu.

2. The measuring receiver will open and perform a 3-second calibration. Wait for this calibration to
finish and connect the unit under test (UUT).

3. Prepare the UUT by selecting the maximum output power and center frequency of the device.
Ensure the UUT output is a CW signal.

4. Prepare the software by entering the center frequency of the UUT and pressing Sync which
recalibrates the measuring receiver for the new center frequency.

Note: For correct operation, ensure the frequency entered is close to the output frequency of the UUT.

After step 4 above, verify the RF Power and RF Frequency readouts are correct and ensure the Relative
Power readouts are stable and very close to zero. A user is now ready to begin making stepped output
power measurements. Perform the following steps for each output power level step.

5. Decrease/step the output power level of the UUT by no more than 10 dB.

6. Record any relevant readouts.
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7. If the measuring receiver suggests to recalibrate the device at a new power range, do so now.
Recalibration takes about 3 seconds and is necessary to make continued accurate
measurements to lower power levels.

8. Returnto step 5.
To start the test over, select a new center frequency or press the Sync button and start over from step 1.

Be careful of IF overload messages which warn that the UUT output power is too large for the current
power range. Avoid this by either decreasing the UUT power or pressing the Sync button to return the
measuring receiver utility to the highest power range.

As the output power of the UUT, the measuring receiver prompts the user to enter new power ranges.
The ranges are finite and a warning will be issued if the user has stepped over a range. To resolve this
increase the UUT output power slowly until entering the next lower power range.

5.9 TIPS FOR BETTER MEASUREMENTS

Signal Hound spectrum analyzers have internal gain and attenuation settings that are automatically
adjusted for the selected reference level. While the software allows the user to manually control these
settings, the AUTO value should be used for nearly all measurements. Manual control may place the
compression point below the reference level, add spurious or residual signals, or raise the noise floor.

There are times when a user wishes to increase the attenuator by 5 or 10 dB to improve linearity. This
can be important for reducing the amplitude of intermodulation products. Rather than changing the
attenuator setting, simply change the reference level. This is easier and more predictable than manually
controlling the attenuator.

For the best sensitivity and lowest noise floor, set the reference level at, or just above, the maximum
input amplitude. To improve linearity and reduce intermodulation products, set the reference level 10 or
20 dB above the signal level.

For narrow-band and CW signals, the noise floor comes down approximately 3 dB for each decrease in
RBW. When measuring low-level CW signals, narrower RBWs are recommended.

For maximum sensitivity, a reference level of -50 dBm or lower is recommended. This will set the
attenuator to a minimum, and set the internal gain to a maximum.

When the detector is set to “average” this is the equivalent to setting the minimum VBW for the current
setup. This will have the lowest peak-to-peak noise floor, but will also average intermittent signals. Set
VBW to auto and the detector to “MIN/MAX" or MAX to measure pulsed or intermittent signals.

For making average power measurements, make sure the detector is set to “average” and “power.” If the
signal is modulated, either set the RBW wider than the modulation, or center the signal and use the
channel power utility.
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6 Additional Features

The Spike™ software has a number of useful utilities. They are described here.

6.1 PRINTING

Use the File = Print menu to print exactly what is shown on the graticule. Be careful, if the software is still
updating traces, the software may not print the desired trace. Use the print preview option to see exactly
what will be printing.

Tip: The active color scheme is used for
printing as well. Under the View — Colors
menu, we provide a simple printer
friendly color scheme to help save ink!

AL,

6.2 SAVING IMAGES

Use the File = Save to Image menu option to save the current graticule view as a PNG, JPG, or BMP image.
The resulting resolution of the image is the exact resolution of the graticule at the time of the save. To
obtain the highest resolution image, maximize the software and slide the control panels out of the way.
The active color scheme is used in the resulting image.

6.3 MANAGING PATH LOSS TABLES

The path loss table dialog provides a user with the ability to manage up to 3 path loss tables and one
antenna factor correction table. Loss tables are [frequency, dB] pairs which characterize loss or gain in
the system. Typical use of loss tables correct for cables, amplifiers, or attenuators. Antenna factor tables
are [frequency, dB/m] pairs which describe the response of an antenna and are generated by calibrating
an antenna. Only one antenna factor table can be loaded and should be loaded into the appropriate
spot to ensure the software recognizes its presence.

See Path Loss, Limit Line, and Antenna Factor Format for more information.

Tables can be loaded and removed through the dialog. The file names of the tables are stored with the
presets and are loaded automatically when loading a preset later. If the file name has changed or moved
since the preset was saved, then the table will be removed.

6.3.1 When Path Loss Tables are Applied

Path loss tables are not applied for every type of measurement Spike provides. The modes in which path
loss tables affect measurements are
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e Standard swept analysis
¢ Real-time spectrum analysis

e Scalar network sweeps

6.4 PATH LOSS, LIMIT LINE, AND ANTENNA
FACTOR FORMAT

All correction and limit tables are loaded into the software in CSV file format. This means each value is
separated by a comma, and each logical set of values is separated by a newline. These types of files can
be edited in spreadsheet document software or even a basic text editor.

Values provided are then linearly interpolated.

Path loss tables are [Frequency (MHz), Gain (dB)] pairs which describe the response of one or more
components in the system. A path loss table might look like this

20.0,0.1
200.0,0.4
2000.0, 1.7

Path loss tables are applied to the received sweep before being displayed or processed. The first and last
values are extended to the start and stop frequencies of the sweep configured. It is good practice to
prefix and postfix your table with zeros if you do not wish to extend your corrections beyond the defined
frequency range.

Antenna factor tables are [Frequency (MHz), Antenna Factor (dB/m)] pairs which describe the response
of an antenna. These tables have the same structure and behavior as path loss tables except they
change the units of measurement to one of electric field strength. Electric field string measurements are
used in compliance testing.

Limit line tables can take two forms, [Frequency (MHz), Min (dBm), Max (dBm)] or [Frequency (MHz),
Max (dBm)]. In the second form, the minimum value is set to a low value which will always pass.

As with path loss tables, the first and last values in the limit line table are extended to the start and stop
frequency of the currently configured sweep.

The limit lines are drawn on the graticule and every trace is tested against them. Indicator text will
appear in the center of the screen denoting whether the trace currently shown passes or fails the limit
line test.

Here is an example of a path loss CSV file built in a spreadsheet program.
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732 0
738 2

And here is the resulting path loss corrections applied to incoming traces for a 10MHz span centered at
735 MHz:

Amplitude (dBm)

1 i i i i
730 732 734 736 738 740

Frequency (MHz)

We can see the linear interpolation between the two points and flat lines off the sides.

6.5 AUDIO PLAYER

Using the Utilities Audio Player menu option, a user can utilize the software to play broadcast audio.
When using Spike™ for audio playback, the dialog box below will appear.
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11 Audio Player LD [

4  Freguency Configuration 4 Audio Configuration
Center Freq a7 1000000 MHz  Audio Type FM -
Bandwidth 120.0000000 kHz
+20Hz Low Pass 5.0000000 kHz
1 kHz *1kHz High Pass 20.0000000 Hz
-20Hz Deemphasis 75000 us
OK

Change the center frequency using the arrow keys, pressing the fine tune frequency adjustments, or
through manual entry. The initial center frequency is the same center frequency displayed on the
graticule when selecting the Audio Player menu option. A user can also manually change or select
various bandwidths and the type of demodulation. A user may also specify audio low pass and audio
high pass filter cutoff frequencies.

All audio related variables other than center frequency are saved with presets.

TRY THIS: Utilize sweep mode to find a
signal of interest, and start the Audio
Player to immediately begin listening at
that frequency.

% I

7 Display Modes

Spike™ provides many ways to view the spectrum. Each type of display is useful for different purposes.
Below is an introduction to some of the views.

7.1 SPECTROGRAM

The software offers two visual representations of a spectrogram, the traditional spectral waterfall and a
three dimensional representation where amplitude is represented by color and height. Our spectrogram
displays show spectral history of up to 128 sweeps. Below is an image of the spectral waterfall displaying
an FM station broadcasting with HD radio. The width of the view is representative of the selected span.
The colors along a horizontal line represent the amplitude of that given sweep. More recent sweeps
appear at the front (bottom) of the display. Low amplitudes are represented by blue, and as amplitude
increases, the color moves through the color spectrum, from blue to green to red.
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Figure 14 : FM Station with HD Radio side bands

7.2 PERSISTENCE

The persistence display is helpful for viewing spectral density over time. Instead of showing a single
trace, persistence uses a number of sweeps to create an image where color is representative of how
often a signal appears. The software uses the color spectrum to represent density over time. If a signal
rarely occurs in a location, a light blue is used to color the trace. If a signal continues to appear in the
same location the color will change from blue to green to red. Red is an indication of a signal persisting in
one location for a good deal of time.

There are two types of persistence displays, one for standard spectrum analysis and one for real-time
analysis. For standard spectrum analysis, persistence is simply an accumulation of the most recent
sweeps. This display is shown below.

Div 10 dB REWY 9.86 kHz VBW 9.86 kHz
Reflevel -10 dBm Atten 10 dB Int Ref

Playback 19/02/2013 11:26:20:088

-10.00

-30.00

-50.00

Arip
dBm

-70.00

-60.00

pL Start 2.4600000 GHz Center 2.4700000 GHz Stop 24800000 GHz
Step 10.0000000 MHz Span 20.0000000 WHz Sweep 32 ms, 1024 points

Figure 15: Sweep mode persistence showing the signal from a poorly shielded commercial microwave oven.
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In real-time mode, persistence is the accumulation of 2/3™ of a second worth of spectrum data. This
means, each update in the persistence display is the accumulation of the result of 1600 - 400000 FFTs.

8 Troubleshooting

If you experience a problem with your Signal Hound, please try these troubleshooting techniques before
contacting us.

This section will contain general troubleshooting tips as well as device specific tips. If a troubleshooting
tip applies to a specific device, the tip will make note of it.

8.1 UNABLE TO FIND OR OPEN THE DEVICE

Ensure the device is plugged in and the green light is on. If it is not, unplug then plug in the device. Once
the green light turns on, use the File menu to try to connect the device again.

8.1.1 The Device Light is solid green and still won't connect

Early BB60A units sometimes require a power cycle after the PC has restarted or woke up from
hibernation. For these units, try a power cycle before restarting the software.

If it is the first time the device has been connected to a PC, the device might require many seconds to
identify and install the latest drivers for the device. Usually a PC will notify you if this identification
process is occurring and when it is finished. Wait until the device has been properly identified by your PC.
You can verify this by finding the device in the device manager. It will bear the Signal Hound name if it
has been identified.

If a power cycle still does not allow you to connect the device, it is possible the device drivers were not
successfully installed. See the Driver Installation section for information about the BB60 drivers.

8.1.2 The device is connected but does not exhibit a solid
green light.

For the BB series spectrum analyzers if the device LED is not solid green after connecting it to the PC
there are a couple steps you can try.

e Power cycle the device by disconnecting the USB cable from the spectrum analyzer end. If the
provided cable is a USB y-cable, ensure both USB ends are connected to the PC before
connecting it to the device.

e Update power management settings. On some laptops and PCs not in the United States,
the default power management settings might be geared towards saving energy. The Signal
Hound spectrum analyzers are high performance USB devices and require a full USB power
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supply to operate normally. In the Control Panel > Power Options, change the power plan
to "high performance”.

If the device is still exhibiting this behavior, try installing the latest manufacturer USB drivers for
your PC. For Windows 8 systems, this includes utilizing Windows updates until no more updates
are available. For Windows 7 systems, determining your chipset version using the control panel
(e.g. Chipset Intel 7 Series/C216) and downloading the latest USB/motherboard drivers for your
system from the Intel website by searching for your chipset with drivers. Only download drivers
from verified sources. For all systems, PC manufacturers provide driver updates on their
website. Search for your PC model and year to find them.

8.1.3 The device disconnects during operation

There are many reasons a Signal Hound device might experience an issue during operation. Some issues
are USB related issues and some might be related to PC performance. Here are some things you can try
to eliminate this behavior.

Disable anti-virus software. We have observed anti-virus software interfering with the operation
of Signal Hound spectrum analyzers on numerous occasions. Remember to re-enable anti-virus
software after closing the Spike software.

Update power management settings. On some laptops and PCs in other countries, the
default power management settings might be geared towards saving energy. The Signal
Hound spectrum analyzers are high performance USB devices and require a full USB power
supply to operate normally. In the Control Panel > Power Options, change the power plan
to “high performance”.

8.2 THE SIGNAL HOUND IS NOT SWEEPING
PROPERLY

If the sweeps shown are not what you expect there are a number of things you can try:

1.

In the preset menu, Presets > Load Default Settings will return the application to default start
up settings. This might be useful if you have entered an unknown state.

Restarting the application is a quick way to reset any unknown settings or state.

The green Preset button performs a hard reset for the device and the software settings. In rare
instances, communication between the application and device can become corrupted. The
Preset button should be used any time the device enters an undesirable state.
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8.3 THE DEVICE IS NOT VALID

In the event the device ceases to operate or becomes corrupted, the application might tell you the device
does not appear to be valid. Before contacting us, attempt to power cycle the device and restart your
computer to ensure nothing else is causing this issue. If the issue persists, please contact us.

8.4 THE DEVICE REPORTS IF OVERLOAD ON
PROGRAM STARTUP

Some Signal Hound devices might report an IF overload condition for a short time after launching the
software or connecting the device through the File menu. This condition is considered normal and is part
of the normal hardware startup process. This condition should last typically less than one second of
operation.

9 Calibration and Adjustment

Contact Signal Hound for more information regarding calibration software and required equipment.

10 Warranty and Disclaimer

©2013-2015 Signal Hound. All rights reserved.

Reproduction, adaptation, or translation without prior written permission is prohibited, except as
allowed under the copyright laws.

The information contained in this manual is subject to change without notice. Test Equipment Plus
makes no warranty of any kind with regard to this material, including, but not limited to, the implied
warranties or merchantability and fitness for a particular purpose.

Signal Hound shall not be liable for errors contained herein or for incidental or consequential damages
in connection with the furnishing, performance, or use of this material.

Refer to the End User License Agreement for additional warranty and disclaimer information covering
the Spike software.

10.1 CREDIT NOTICE

Windows® and Excel® are registered trademarks of Microsoft Corporation in the United States
and other countries.
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Intel® and Core™ are trademarks or registered trademarks of Intel Corp. in the United States and other
countries.

Labview® is a registered trademark of National Instruments Corporation in the United States and
other countries.

Matlab® is a registered trademark of The MathWorks, Inc. in the United States and other countries.

11 Appendix

11.1 CONSTELLATION MAPPINGS
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Note: Positive I-axis is to the right, positive Q-axis is to the top.

Offset QPSK is the same as QPSK, except the Q is delayed by %2 symbol.
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